Introduction to
Outlook 2007
for Keyboard Users

Prepared by the staff and faculty of
The Hadley School for the Blind
Winnetka, Illinois

Copyright © 2010
All rights reserved. No part of this course may be reproduced in any form or by any electronic or mechanical means (including photocopying, recording, or information storage and retrieval) without written permission from The Hadley School for the Blind.
Using Outlook 2007 ................................................................. 1
Overview .................................................................................. 1
Establishing Internet Service and an Email Account .................. 1
Abbreviations and Common Terms ............................................. 1
Setting Defaults ........................................................................ 3
Configuring Outlook .................................................................. 3
Setting the Inbox as Default ....................................................... 4
Reading Pane ............................................................................. 5
Auto Preview .............................................................................. 5
Show in Groups ......................................................................... 6
Basic Email ................................................................................ 6
The Email Address ..................................................................... 6
Receiving a Message .................................................................. 7
Composing a Message ............................................................... 7
Reading a Message .................................................................... 9
Deleting a Message ................................................................... 10
Replying to Email Messages .........................................................
  Reply ...................................................................................... 10
  Reply to All .............................................................................. 11
Using Outlook 2007

Overview

It is assumed that your personal computer has Windows and a screen reader or a magnification program, and that you are familiar with these programs and your keyboard.

This user guide is an introduction to Outlook 2007, and does not include instructions for all of the functions built into the program.

Establishing Internet Service and an Email Account

To set up an email account, you must contact your Internet service provider (ISP) for instructions.

Abbreviations and Common Terms

alt: Alternate key
applications key: Third key to the right of the space bar. Opens a context menu.
arrows: When this term is used, you should use the up, down, left, or right arrow keys as instructed.
ctrl: Control key
esc: Escape key
keyboard shortcuts: All keyboard shortcuts and keystrokes are enclosed in parentheses.

menus, buttons, folders, edit boxes, fields, windows, and tabs: These items are enclosed in brackets.

modifier keys: Some commands require modifier keys: the Control (ctrl), Alternate (alt), and Shift (shift) keys. Modifiers are "press and hold" keys, while individual letters and numbers are "strike and release" keys.

There are three possible combinations:

1. Press and hold down a modifier key plus strike a second key.
   **Example:** (alt + f)
   (shift + 2) **Note:** do not use the number pad.

2. Press and hold down two modifier keys plus strike a third key.
   **Example:** (ctrl + shift + i)

3. Press and hold down a modifier key plus strike a key and release. Then strike a key, and strike another key.
   **Example:** (alt + n, a, f) Press (alt + n) and release, then strike a, then strike f.
Setting Defaults

Configuring Outlook

By default, the following folders are created when Outlook is installed on your computer:

- Cabinet
- Calendar
- Contacts
- Deleted Items
- Drafts
- Inbox
- Journal
- Junk email
- Notes
- Outbox
- RSS Feeds
- Sent Items
- Sync Issues
- Tasks
- Work In Progress
- Search Folders
Setting the Inbox as Default

To set the [Inbox] as the default opening window follow these steps:

1. Open Outlook and navigate to the [Inbox]: (ctrl + 1)

2. Open the [Tools] menu: (alt + t)

3. Select the [Options] menu: (o)

4. Navigate to the [Other] page tab: (ctrl + tab)

5. Select the [Advanced Options] button: (o). You will be placed in [General Settings], on the [Browse] button.

6. Press (enter) and the [Select Folder] dialog will open.

7. Select the [Inbox]: (i) then (enter). This will select the [Inbox] as the default opening window and will place you back in the [Advanced Options] window.

8. Navigate, (tab) or (shift + tab), past numerous check boxes and other buttons, which should not be changed at this time, until you reach the [OK] button.
9. Press (enter). This will save the selection and place you back in the [Options] window.

10. Return to the [Inbox]: (esc)

The [Inbox] is now the opening default window.

**Reading Pane**

To turn off this feature:
1. Open the [Reading Pane] submenu: (alt + v, r)

2. Select [Off]: (o). This will disable the reading pane and return you to the [Inbox].

**Auto Preview**

To turn off this feature:
1. Open the [View] menu: (alt + v)

2. Move to [Auto Preview]: (down arrow) twice. If your screen reader says:
   a. "Auto Preview Checked P": (p) or (enter). This will disable [Auto Preview] and return you directly to the [Inbox].
b. "Auto Preview P" (without saying "Checked"): The feature is already disabled. Press (esc) twice to return to the [Inbox].

**Show in Groups**

To turn off this feature:

1. Open the [View] menu: (alt + v)

2. Open the [Arrange By] submenu: (a)

3. Navigate to [Show in Groups]: (up) arrow. If your screen reader says:
   a. "Show in Groups checked w": (enter). This will disable this function and return you directly to the [Inbox].
   b. "Show in Groups w" (without saying "Checked"): The feature is already disabled. Press (esc) three times to return to the [Inbox].

**Basic Email**

**The Email Address**

An email address is an address for sending and receiving email messages. It consists of three
components: a username, @ (the *at* sign) and a domain name.

- **Username:** A username is a unique identifier that can be the actual name of an individual, a nickname, an organization's name, or a random series of letters (any combination of upper- and lowercase) and numbers.

- **@ (At Sign):** This sign connects the username and domain name. To input this sign, press (shift + 2).

- **Domain Name:** This specifies the company or organization providing the email service for the email address. For example, a domain name might be yahoo.com or Hadley.edu. A dot extension such as .com, .org, .edu, .us, .ca, .uk, or .info comes after the domain name.

  **Example:** jane@yahoo.com

**Receiving a Message**

Outlook will receive email messages automatically. To check for new messages at any time: (ctrl + m) or (f9).

**Composing a Message**

Creating an email message is the most frequent task you will perform. Microsoft Office Word 2007 is the
email editor used by Outlook 2007 for email messages. However, you do not need to open Word 2007 to compose an email message. Follow these steps to compose a message:

1. Open Outlook.

2. Open a [New Message] window: (ctrl + n). You will be placed in the [To] edit box.

3. Type in the email address of the party you are sending the email to.
   **Note:** If you have emailed this contact in the past, Outlook may present you with a drop-down list of matching addresses to choose from. For further instructions, see "Add A Contact" on print page 20.

4. **Optional** (Tab) once to [Carbon Copy—CC]: If you need to send this message to additional recipients, type in their email address(es). Separate each address with a semicolon and space. Skip this step if you have no carbon copy address(es).
5. (Tab) until you locate the [Subject] edit box. The subject is a very short, single phrase about the email.

6. To move to the [Message] edit box, (tab) once. This is where you type the body of your message.

7. Once you have completed your message, send it: (alt + s)

Reading a Message

1. Open Outlook. Give Outlook a few seconds to update your [Inbox].

2. By default, you are in the [Inbox]. Navigate through the [Inbox] by using the (up) and (down) arrows. Select the message you want to read: (enter)

3. By default, you are placed in the body of the message. Use standard text navigation commands to read the message. To move back to the [To], [CC], [Subject], and [Attachment] boxes: (shift + tab)

4. To close a message: (esc)
Deleting a Message

You may delete a message when it is either open or closed.

1. **Closed Message:** Arrow (up) or (down) to the message you want to delete: (delete) or (ctrl + d). The message will be moved to your [Deleted Items] folder, and the cursor will be placed on the next message.

2. **Open Message:** With the message open: (ctrl + d). The message will be moved to your [Deleted Items] folder, and the cursor will be placed on the next message.

Replying to Email Messages

*Reply*

Use the following steps to reply to a message:

1. Locate and open the message you want to reply to: (enter)

2. To reply: (ctrl + r). The focus will be placed above the original message, where you can type in your own comments. The [To], [CC], and [Subject] edit
boxes will contain the original sender's email address(es) and subject.

3. Send it: (alt+s)
   
   **Note:** Once you send your reply, the cursor will be placed back in the open message you replied to. To close the message: (esc)

   **Note:** If you receive a reply to a message you sent, "RE:" will precede the subject of that email. When navigating your inbox, your screen reader may also say, "Re", "Replied", or "Replied to," indicating that the message is a reply to an email you sent.

*Reply to All*

This function is used when the originator of an email sends it to more than one recipient and you wish to send your reply to all the recipients:

1. Locate and open the message you want to reply to: (enter)

2. To reply to all: (ctrl+shift+r). The focus will be placed above the original message, where you can type in your own text. The [To], [CC], and
[Subject] edit boxes will contain the original sender's recipients address(es) and subject.

3. Send it: (alt + s).

**Forwarding an Email Message**

To forward an email, follow these steps:

1. Locate and open the message you want to forward: (enter)

2. Begin the forwarding process: (ctrl + f). This places the cursor in the [To] edit box. Type in the email address of the party you are forwarding the email to.

3. (Optional) From the [To] edit box, press (tab) once to move to the [CC] edit box. Type in the email address(es).

4. Move to the [Subject] edit box: (tab) The original subject of the message is retained with the addition of "FW:" at the beginning of the subject, designating it as a forwarded message.

5. The next (tab) will take you to one of two different edit boxes:
a. If there is an attachment, this (tab) will place the cursor in the [Attachment] edit box, at the end of the attachments name. Pressing (tab) again will place the cursor in the [Message] edit box.

b. If there is no attachment, this (tab) will move the cursor to the [Message] edit box.

6. Space is available in this box for you to type in any comments you wish. Your comments will be placed above the original message.

7. Send the message: (alt+s)

**Attachments**

An email attachment is any file that you "clip" or "attach" to an email message. The file may be an audio file, .wav or .mp3; a document file, .doc, .txt, or .pdf; a compressed zip file, .zip; or a picture, .jpg or .tif. An executable file, .exe, normally cannot be attached to an email. There are three ways to attach a file to an email.
Method 1: Attaching a File While in Word or Excel

If you only want to send a single attachment, which was created in Microsoft Word or Excel, follow these steps:

1. Open the file you want to send by using the file's default program: MS Word or Excel

2. Go to the [File] menu: (alt + f)

3. Go to the [Send] option: (d). The [Send a copy of the document to other people] window will open.

4. Select the email option: (e)

5. A blank email message will open. The [Subject] and [Attachment] edit boxes will contain the name of the document. (The document is already attached.)

6. You must type in the [To] email address. You may also type in a [CC] address if desired.

7. (Tab) through the [CC] and [Attachment] edit boxes to the email [Message] box, and type in any message you want to include.
8. To send the email: (alt+s). Outlook will send the email and close, placing you back in the document you attached.

**Method 2: Using the Applications Key**

The Applications key is located on the bottom row of the keyboard, often the third key to the right of the space bar. (Please note: A laptop keyboard may have a different configuration.)

To use this method you must locate the file on your computer by using Windows Explorer, My Computer, or the file's default program.

**Select the file but do not open it.**

1. Press the Applications key, and move to the [Send To] item: Press (n) until you reach [Send to], press (enter)
2. A submenu will open. Select [Message Recipient] (m)
3. Outlook will open in a new email message and the cursor will be placed in the [To] edit box.
   a. You must complete the [To] email address.
   b. If desired, type in a [CC] address(es).
c. The [Subject] edit box will already be completed with the name of the file.

d. The file will already be attached, with the name of the file in the [Attached] edit box.

4. Move to the [Message] edit box: (tab), and type in any message you want to include.

5. Send the email: (alt+s).

**Method 3: Attaching a File with Outlook Open**

When attaching a file while in Outlook, it is important to know where the file resides on your computer, such as the drive letter or folder name. To attach a file, follow these steps:


2. Access the [Insert Ribbon]: (alt+n)

3. Type the letter (a) followed by (f).
   a. The [Insert File] window will open.
   b. The cursor will be in the [File Name] edit box.
   c. Type in the "path" to the file you wish to attach. The path consists of the drive letter,
and/or folder name, and the file name with its extension.

Examples:

- c:\filename.doc
  c:\working hard.doc
- c:\foldername\filename.doc
  c:\my documents\working hard.doc


**Note:** You can attach additional files to the email by repeating steps 3 through 5 for each file before sending the email.

**Saving Attachments**

Occasionally you might receive an email with an attachment that you would like to save. Saving the attachment creates and saves a copy of the file but does not remove it from the original email. Deleting the email will move the message and the attachment to your [Deleted Items] folder. Deleting the message will not affect the attachment you saved.
To save an attachment, follow these steps:

1. Open the email message that contains the attachment.

2. Press (shift + tab) once, and the cursor will be placed in the attachment field "on" the word [Message]. This is a dummy field and does nothing. Move off this field and into the [Attachment] edit box: (ctrl + right arrow)

3. Move through the attachments: (ctrl + right or left arrow) and select the attachment you wish to save: (enter)

4. The cursor is now in the [Opening Mail Attachment] window: Three buttons are available; [Open], [Save], or [Cancel]. The [Save] button is the default: (enter)

5. The cursor is now in the [Save As] dialog window, in the [File Name] edit box, at the end of the file name.
6. Press (home). Then type the complete path for the location where you wish to save the file. Since the file name is already in this box, do not retype it.

Example:

- File name: working hard.doc
- The path you need to add before the file name is:
  
c:\my files\
- The complete path is now:
  
c:\my files\working hard.doc
- If the file is in a subfolder in the folder [My Files], the path would be:
  
c:\my files\subfolder name\working hard.doc

Note: If you are using a screen reader, it may not give you an indication that the attachment has been saved. The general rule is: "If you do not receive an error message, then it worked properly."

Note: While in step 4, you may open the file rather than saving it. Use the (up) arrow once, and press (enter). It will open the attachment using the default program associated with the attachment's file type.
Note: While in step 4, you may cancel any action by pressing the (down) arrow once to reach [Cancel]: (enter)

Caution
You should be very careful selecting attachments you wish to save or open, because sending attachments via email is a popular way that viruses and spam are spread. The general rule is: "If you don't know and trust the party that sent the message, don't open or save it."

Contacts or Address Book
Contacts is an Outlook database that may include names and email addresses for later use. This list may also be referred to as the Address Book. Should you prefer to simply type the email address as you compose a message, you do not need to complete this database.

AutoComplete
Separate from Contacts, AutoComplete is a feature that displays suggestions for names and email addresses as you begin to type them in the [To] or [CC] edit boxes. These suggestions are possible matches.
from a list of names and email addresses that you have previously used, known as the "AutoComplete List." You can select from the list of suggestions using the (up) or (down) arrows to locate the address you need. To select the address: (enter) or (tab).

**Add a Contact**

Follow the steps below to create a new contact without sending an email.

1. Open Outlook and switch to [Contacts]: (ctrl + 3)

2. Create a new [Untitled Contact] record: (ctrl + n).
   
   This window contains the following items:
   
   - Contact's full name
   - Company name
   - Job title
   - File as
   - Contact photo
   - Email address(es)
   - Display as
   - Web page address
   - Instant message address
   - Phone numbers
Most of this information is optional; however, you must type in the contact's name and email address in the appropriate edit boxes. To access these items, use (tab). To go back, use (shift + tab).

3. When you open a new [Untitled Contact] record, you are automatically placed in the [Full Name] edit box. Type in the contact's first name, middle initial (if desired), and last name, in that order. The contact's name will automatically be placed in the [File As] edit box in reverse order; last name, first name, middle initial. This will keep your contacts listed in alphabetical order.

4. To locate the [email] edit box: (tab) several times.

5. Once in the [email] edit box, type the contact's email address.

6. Press (tab) and you will be placed in the [Display As] edit box. The contact's full name and email address will automatically be placed here.

7. Save the Contact record: (ctrl + s)
Note: your screen reader may not provide audio confirmation of this action.

8. To close the contact record: (esc)

9. To return to the [Inbox]: (ctrl + 1)

Add a Contact from an Email Message

When you have received an email message and want to add the sender's email address to your Contacts List follow these steps:

1. Open the [Inbox] and select the message from the individual you wish to add to your contacts list. Do not open the message.

2. To copy the contact's email address: (ctrl + c). Your screen reader may not confirm this action.

3. Open your [Contact] database: (ctrl + 3). Your screen may not confirm this action, or it may say "click here to add a new ...". Ignore any instructions until completing step 4.

4. Paste the contact in the [Contact] database: (ctrl + v). The contact's name, file as name, email address, and display name will automatically be
placed in the contact record. The body of the email message you copied will be placed in the [Notes] edit box. You may add, edit, or delete information as necessary.

5. Save the entry: (ctrl + s). Your screen reader may not confirm the save or may say "controls."

6. Close the contact record: (esc)

7. Return to the [Inbox]: (ctrl + 1)

Delete a Contact

To delete a contact, follow these steps:

1. Open Outlook. You should be in your [Inbox] by default.

2. Open the [Contacts List]: (ctrl + 3)

3. Select the contact you wish to delete, by using the (up) and (down) arrows.

4. Delete the contact: (delete). Be absolutely sure you want to complete the delete process, because you will not be asked to confirm or cancel this action.
5. Close the [Contact List]: (alt + 1). You will be returned to the [Inbox].

Signatures

Creating Signatures

You can personalize any e-mail message by adding a signature. Your signature can contain your name, contact information, and any text you desire.

You can also create several different signatures and select the one you want for different recipients. For example, you might want a professional signature for emails related to your work but prefer a more personal signature with a quote for family and friends.

The following instructions will explain how to create one signature.

Open Outlook. You should be in your [Inbox]. The following steps work only if you are [Creating a New Signature]:

1. Open the [Tools] menu: (alt + t)

2. Select [Options]: (o). You will be on the [Preferences] tab.

4. Open the [Signature] window: (alt + g). You will be placed on the [OK] button.

5. To access the [New] button: (alt + n). You will be placed in the [New Signature] window.

6. Type a title (home, work, personal, etc.) for the signature and press (enter). This saves the title of the signature and returns you to the [E-mail Signature] window.

7. Move to the [New Message] combo box: (alt + m). The default setting is [None]. Arrow (up) and (down) to select the title of the signature you previously created in step 6.

8. Move to the [Replies/Forwards] combo box: (alt + f). Arrow (up) and (down) to select the title of the signature you previously created in step 6.

9. Move to the [Edit Signature] box: (tab). You will (tab) through the following items:
Font, Font Size, Bold, Italics, Underline, Font Color, Left, Center and Right Justify, Business, Picture, and Insert Hyperlink. Make any changes you wish as you advance through these items.

10. In the [Edit Signature] box, type in the actual signature you desire, which can contain multiple lines. You must press (enter) at the end of each line. An example is:
Sincerely,
your name
address
city, state, zip code
phone number
personal quote

11. After completing the signature box, (tab) to the [OK] button and press (enter). Your signature will be saved and you will be returned to the [Options] window and placed on the [Mail Format] tab. To create an additional signature, press (alt + g) and follow the instructions starting with step 5.
Once you have typed in all of the signatures you desire, (Tab) to the [OK] button and press (enter). You will be returned to the [Inbox].

**Editing Signatures**

To edit an existing signature:

1. Open [Tools]: (alt + t)

2. Open [Options]: (o)

3. Select the [Mail Format] page tab: (ctrl + tab) until located.

4. Open the [Signatures] window: (alt + g). You will be placed on the [OK] button.

5. (Tab) to the [Select Signature to Edit] list box and select the signature you want to edit using the arrow keys.

6. (Tab) to the [Edit Signature] box. Use standard text navigation and editing commands to edit the signature.

7. (Tab) to the [OK] button and press (enter). You are returned to the [Options] window and placed on
the [Mail Format] page. If you wish to edit another signature, press (alt + g) and repeat the process starting with step 5.

Once you have edited all of the signatures you desire, (tab) to the [OK] button and press (enter). You will be returned to your [Inbox].

Deleting Signatures

To delete an existing signature, follow steps 1 through 4 in the section Editing Signatures. Once you have selected the signature you want to delete, press (alt + d). A dialog box will open and ask you if you are certain you want to delete the signature. You can take one of two actions:

Deleting the Signature

Press (alt + y). If there is more than one signature title, the next title will be selected and you will be placed on the [OK] button. If you wish to delete another signature title, press (alt + d) and repeat the process.
Cancelling the Action

If you wish to cancel the deleting process, press (alt + n). This action will keep the current signature title selected and place you on the [Delete] button.


If you are finished with this process: (esc). You will be returned to the [Inbox].

Selecting Optional Signatures

These instructions assume that you have created more than one signature for different recipients. To select the signature for an email, first complete the email and ensure the cursor is positioned at the end of the body of the email. Do not send it. Follow these steps:

1. Access the [Insert] ribbon: (alt + n)

2. Access the [Signature] button: (g). Your list of signatures will open.

3. Arrow (up) and (down) through the list to locate the signature you wish to use.
4. At this point you have two options:
   a. Select one of the signatures and press (enter).
      You will be taken back to the email message,
      the signature will be inserted in the message
      and the process is complete.
   OR
   b. Press (s) to open the [Signatures and
      Stationery] window, [Email Signature] tab,
      where you may add, delete, or edit signatures
      using the instructions provided in the earlier
      sections Creating Signatures and Editing
      Signatures.

   **Spelling and Grammar Checking**

   Spell-checking double-checks the spelling and grammar
   of an email you have composed. The spell-checker will
   check both the subject line and the body of the email.
   However, it will not check any attachments
   accompanying the email. There are two edit boxes in
   the spell-checking window: [Not in Dictionary] and
   [Suggestions].

   **To Begin the Process**

   1. Open Spelling and Grammar: (f7).
2. You will be placed in the [Not in Dictionary] window and the first misspelled word will be spelled, followed by the first word in the [Suggestions] window.

**Note:** Misspellings in the subject line will be identified first.

**Note:** Words that are identically misspelled may be treated differently, based on spacing, capitalization, and punctuation. Because of this, the use of (alt + l), which is Correct All, is not recommended.

3. Two methods for making corrections follow: manual or automatic.

*Manual Correction*

a. After the misspelled word is voiced, press the (down arrow) once to access the [Not in Dictionary] window. The cursor will be placed at the end of the misspelled word.

b. Use standard editing commands and keystrokes to make the corrections.

c. After making the correction(s): (alt + c). This confirms and makes the change. If you change
your mind before you press (alt + c), press (alt + u)
to cancel the change(s) you typed.

**Note:** It should be noted that different screen readers will treat the manual corrections process in different ways. You will need to experiment with your system to figure out the correct process for you.

**Automatic Correction**

a. After the misspelled word is voiced, press (alt + n) to move to the [Suggested] words list.

b. Use the (up) and (down) arrow keys to find the spelling you want and press (alt + c) to make the correction. The spell-checker will continue to the next misspelled word.

**Acronyms, Abbreviations, Proper Names, and Alternative Spellings**

Many times the spell-checker will identify these as misspelled. If you know the selected word is not misspelled, press (alt + i) to ignore the spelling once or (alt + g) to ignore the spelling throughout the message.

If it is a spelling that you use regularly, (alt + a) will add it to the spelling dictionary.
Grammar Checking

To activate or deactivate grammar checking, press (alt + k). This check box is either checked (active) or unchecked (inactive). Grammar checking is considered an advanced function and is not covered in this document.

Creating and Deleting a Folder

Creating a Folder

1. Open Outlook. Open the [Create New Folder] window: (ctrl + shift + e). The cursor is in the [Name] edit box. Type the name of the new folder.

2. Press (alt + f) to access the [Folder Contains] combo box.

3. This folder contains a list of seven types of data. Use the (up) and (down) arrows to scroll through the list to select the appropriate data type. You may skip this step if you wish.

4. Press (alt + s) to access the [Select Where to Place the Folder] window.
5. This window contains a list of the default folders in Outlook.

**Note:** Your screen reader may not read the name of this window. However, you will be placed randomly on a folder in this list, and the folder name will be announced.

6. Use the (up) and (down) arrows to locate the default folder you wish to place your new folder in.

7. Once the default folder is identified, press (tab) to move to the (OK) button and press (enter). Your folder will be created in the default folder you selected, and you will be returned to the point where you started.

**Deleting a Folder**

1. Open Outlook. Move to the [Mail Folders] window: (ctrl + shift + tab) twice. This window contains a list of default folders and folders you have created.

2. When you originally created a folder, you were required to place it in an Outlook default folder. Locate the default folder using the (up) and (down)
arrows or by typing in the first letter of the default folder name.

3. Expand the main folder: (right arrow)

4. (Arrow down) to the folder you wish to delete.

5. Press the (Applications key), which often is the third key to the right of the space bar, and a context menu will open.

6. To delete: (d). You will be asked to confirm this action.

7. Press (y) for yes or (n) for no.

If you select yes, the folder is deleted and you are returned to the default folder, which contained the folder you just deleted. Press (ctrl + 1) to return to the [Inbox].

If you select no, the folder will remain and you will be placed on that folder. Press (ctrl + 1) to return to the [Inbox].
Outlook 2007 Keyboard Shortcuts

This is not an all-inclusive list of shortcut keystrokes. As you become more experienced with Outlook 2007, you will find more keystrokes for different features and functions in the program.

(alt + a) In Spell Checking: Add a spelling to the dictionary
(alt + c) In Spell Checking: Confirm a spelling change
   In Signatures: Move to the [Select Signature to Edit] window
(alt + d) In Signatures: Delete a signature
(alt + f) Open the [File] menu
   In Creating Signatures: Move to the [Replies/Forward] combo box
   In Creating a Folder: Places you in the list of data types
   In Signatures: Choose [Default Signature, Replies/Forwards] combo box
(alt + g) In Spell Checking: Ignore All
   In Signatures: Open the [Signature] window
(alt + i) In Spell Checking: Ignore Once
(alt + k) In Spell Check: Toggle [Grammar Check] on and off

(alt + l) In Spell Checking: Change All (Not recommended for use)

(alt + m) In Signatures: Move to the [Choose Default Signature, New Message] combo box

(alt + n) In Spell Checking: Move to the [Suggestions] window

In Send an Email: Open the [Attachment Ribbon]

In a Confirmation Box: Is option (No)

In Signatures: Create a new signature title

(alt + o) In Spell Checking: Options (not explained)

(alt + r) In Spell Checking: AutoCorrect

(alt + s) Send an e-mail message

In Creating a Folder: Places you in the [Select Where to Place the Folder] list of folders

(alt + t) Open the [Tool] menu from anywhere in Outlook

(alt + u) In Spell Checking: Undo spelling correction

(ctrl + 1) Move to the [Inbox] from anywhere

(ctrl + 3) Move to the Contact List from anywhere

(ctrl + c) Copy

(ctrl + d) Delete a closed or open email message
(ctrl + f) Forward an e-mail message
(ctl + m) Check for new email from anywhere
(ctl + p) Print
(ctl + r) Reply to an e-mail message
(ctl + s) In Contacts: Save a new contact
(ctl + v) Paste
(ctl + x) Cut
(ctl + y) Go To folder
(ctl + right arrow) In Saving Attachments: Moves you to the [Attachments] field
(ctl + right or left arrow) In the Attachments window: Move through the list of attachments if there is more than one
(ctl + shift + b) Open the Address Book
(ctl + shift + i) Switch to the [Inbox]
(ctl + shift + o) Switch to the [Outbox]
(ctl + shift + r) When sending an email message: Reply to All
(f1) Outlook Help from anywhere
(f7) Start Spell Check
(f9) Check for new messages
(esc) Cancel current task